


Hardware User Manual, 1st Ed.5–64

Chapter 5: Analog I/O Modules

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

P3-16DA-1 Analog Output (continued)
Module Configuration

Using the Hardware Configuration tool in 
the Productivity Suite programming software, 
drag and drop the P3-16DA-1 module into 
the base configuration.   
Select Automatic Module Verification or No 
Verification and Enable Hot Swap and Stop 
Mode Values. If desired, assign a User 
Tagname to each output point (channel) 
selected and to each Status Bit Item.
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P3-16DA-1 Analog Output (continued)
LCD Panel Display

Momentarily Press  

SEL button to 

toggle through 

secondary displays 

 







































Error Messages – An existing error will be 
inserted into the cycling Status Info screen.

This screen will  
auto cycle with 
status information 
 













Hold SEL button down to cycle through primary screens. Release button to select screen. Power On 













































































































Appears 
initially 

These screens will  
then auto cycle 
 
































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P3-16DA-2 Analog Output
The P3-16DA-2 Voltage Analog Output Module provides sixteen channels of 
±10VDC outputs.

ULC USR

We recommend using prewired ZIPLink cables and
connection modules. See Chapter 3. 

Terminal block cover included. If you wish to hand-
wire your module, a removable terminal block is
sold separately. Order part number P3-RTB. 

Output Specifications
Output Channels 16 

Module Signal Output Range ±10VDC

Output Signal Resolution 16-bit

Resolution Value of LSB

(least significant bit)

±10V = 305µV/count

1 LSB = 1 count 

Data Range -32768 to +32767

Output type (sourcing/sinking) Voltage (10mA max current)

Output Value in Fault Mode 0V

Output Impedance 0.2� typical

Load Impedance � 1000�

Maximum Capacitive Load .01µF maximum

Allowed Load Type Grounded

Maximum Inaccuracy 0.1% of range

(including temperature drift)

Maximum Full Scale Calibration

Error (not including offset error)

±0.025% of range maximum

Maximum Offset Calibration Error ±.025% of range maximum

Accuracy vs. Temperature ±25 ppm/ °C maximum f.s. calibration

change (± .0025% of range / °C)

Max Crosstalk -96 dB, 1 LSB

Linearity Error (end to end) ±16 LSB maximum (±0.025% of full scale)

Monotonic with no missing codes

Output Stability and Repeatability ±10 LSB after 10 min. warm-up (typical)

Output Ripple 0.05% of full scale

Output Settling Time 0.3 ms max, 5 µs min (full scale change)

All Channel Update Rate 0.6 ms

Maximum Continuous Overload Outputs current limited to 40mA typical

Continuous overloads on multiple outputs

can damage the module.

Type of Output Protection 0.1µF Transient Suppressor

External DC Power Required 24 VDC (-20% / + 25%), 252mA
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Terminal block sold
separately; terminal
block cover included

with module.



P3-16DA-2 Analog Output (continued)

*Meets EMC and Safety requirements. See the Declaration of Conformity for details.

WARNING: Explosion hazard – Substitution of components may
impair suitability for Class I, Division 2.
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Removable Terminal Block Specifications
Number of Positions 20 screw terminals

Wire Range 22-14 AWG (0.324 to 2.08 sq. mm)  

Solid / stranded conductor

3/64 in. (1.2 mm) insulation maximum

"USE COPPER CONDUCTORS , 60°C" or equivalent.

Screw Driver Width 1/4 inch (6.5 mm) maximum

Screw Size M3 size

Screw Torque Field terminals – 7 - 9 in./lb (.0.882 - 1.02 Nm)

Self-jacking screws – 2.7 - 3.6 in./lb (0.3 - 0.4 Nm).

Do not overtighten screws when installing terminal block.

General Specifications
Operating Temperature 0° to 60°C (32° to 140°F),

Storage Temperature -20° to 70°C (-4° to 158°F)

Humidity 5 to 95% (non-condensing)

Environmental Air No corrosive gases permitted 

Vibration MIL STD 810C 514.2

Shock MIL STD 810C 516.2

Field to Logic Side Isolation 1800VAC applied for 1 second

Insulation Resistance >10M� @ 500 VDC

Heat Dissipation 6.4 W

Enclosure Type Open Equipment

Agency Approvals UL508 and UL1604 (Certified for Canada and USA)

CE (EN61131-2*)

This equipment is suitable for use in Class I,

Division 2/Zone 2, Groups A, B, C, and D or non-

hazardous locations only.

Module Keying to Backplane Electronic

Module Location Any I/O slot in any local, expansion, or remote

base in a Productivity3000 System.

Field Wiring Removable terminal block (not included). Use

ZIPLink wiring system or optional terminal block.

See Chapter 3.

EU Directive See the "EU Directive" topic in the

Productivity3000 Help File. Information can also

be obtained at: www.productivitypac.com

Terminal Type (not included) 20-position removable terminal block

Weight 105g (3.73 oz)



P3-16DA-2 Analog Output (continued)
Wiring Diagrams

FIELD WIRING INTERNAL  MODULE CIRCUITR Y 

24VDC-

24VDC+

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

voltage sink/source 

ISOLA TED ANALOG 
CIRCUIT  POWER 

ISOLA TED ANALOG 
CIRCUIT  COMMON 

CH1 DAC 

CH2 DAC 

CH3 DAC 

CH4 DAC 

CH6 DAC 

CH5 DAC 

CH7 DAC 

CH8 DAC 

CH9 DAC 

CH10 DAC 

CH1 1 DAC 

CH12 DAC 

CH14 DAC 

CH13 DAC 

CH15 DAC 

CH16 DAC 

V1+ 

V2+ 

V3+ 

V4+ 

V5+ 

V6+ 

V7+ 

V8+ 

COM 

COM 

V9+ 

V10+ 

V1 1+ 

V12+ 

V13+ 

V14+ 

V15+ 

V16+ 

-    +

24 VDC User 
Supplied Power 

AC or DC
Power Supply

  0 - 10  

Load

Voltage Output Circuits

V+

COM

Load
Power Supply

±10 VDC

Load

V+

COM

Load
Power Supply

  -10 - 0  

VDC Load

V+

COM
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P3-16DA-2 Analog Output (continued)
Module Configuration

Using the Hardware Configuration tool in 
the Productivity Suite programming software, 
drag and drop the P3-16DA-2 module into 
the base configuration.   
Select Automatic Module Verification or No 
Verification and Enable Hot Swap and Stop 
Mode Values. If desired, assign a User 
Tagname to each output point (channel) 
selected and to each Status Bit Item.
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P3-16DA-2 Analog Output (continued)
LCD Panel Display

Momentarily Press 

SEL button to

toggle through

secondary displays







































Error Messages – An existing error will be 
inserted into the cycling Status Info screen.

This screen will 
auto cycle with
status information













Hold SEL button down to cycle through primary screens. Release button to select screen. Power On 















































































































































Appears 
initially 

These screens will  
then auto cycle 
 

Note: SPARE denotes deselected channel 
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P3-8AD4DA-1 Analog Input/Output
The P3-8AD4DA-1 Current Analog Input/Output Module provides eight channels of 
current sinking 0-20mA inputs and four channels of current sourcing 4-20mA outputs.

ULC USR

We recommend using prewired ZIPLink cables and
connection modules. See Chapter 3. 

Terminal block cover included. If you wish to hand-
wire your module, a removable terminal block is
sold separately. Order part number P3-RTB. 

Input Specifications
Input channels 8 (1 common)

Module Signal Input Range 0 - 20mA 

Signal Resolution 12-16 bit, depending on Input Resolution

Input Resolution & Update Rate

See Note 1
Fine: 7.1ms, 0.305µA, 16 bit 

Medium: 1.78ms, 1.22µA, 14 bit 

Coarse: 444µs, 4.88µA, 12 bit

Data Range 0-65535 counts

Input Type Single Ended (one common)

Maximum Continuous Overload ±31mA

Input Impedance 250� ±0.1% ¼W

Hardware Filter Characteristics Low pass 1st order, -3dB @ 48Hz

All Channel Update Rate

See Note 2
Fine: 56.8ms 

Medium: 14.24ms 

Coarse: 3.55ms

All Channel Update Rate 56.8ms

Open Circuit Detection Time Zero reading within 1s

Conversion Method Successive approximation

Accuracy vs. Temperature ±15PPM / °C maximum

Maximum Inaccuracy 0.1% of range

Linearity Error (end to end) 0.015% of range maximum

Monotonic with no missing codes

Input Stability and Repeatability ±0.015% of range (after 10 min. warm up)

Full Scale Calibration Error 

(not including offset)

±0.05% of range maximum

Offset Calibration Error ±.0.05% of range maximum

Maximum Crosstalk -96 dB  ±1 - 0.015% of full scale maximum

Recommended Fuse (external) Edison S500-32-R, 0.032A fuse 

External DC Power Required 24 VDC (-20% / + 25%), 183mA maximum

Note 1: The Input Resolution of Fine returns 16 bit resolution. Medium and

Coarse are 14 and 12 bit respectively. The 12 and 14 bit input values are scaled

to 0-65535.

Note 2: Valid when all channels are set for the same Input Resolution.
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Terminal block sold
separately; terminal
block cover included

with module.



P3-8AD4DA-1 Analog Input/Output (continued)

Output Specifications
Outputs per module 4 (1 common)

Module signal output range 4-20mA 

Output Signal resolution 16-bit

Resolution Value of LSB

(least significant bit)

0.244µA/count

1 LSB = 1 count

Data Range 0 - 65535 counts

Output Type Current sourcing, 20mA max

Output Value in Fault Mode � 4mA

Load Impedance 

(Minimum Ext. Power Supply)

0-480� (19.2 VDC)

0-600� (21.6 VDC)

0-715� (24.0 VDC)

0-840� (26.4 VDC)

0-1010�(30.0 VDC)

Maximum Inductive Load 1 mH 

Allowed Load Type Grounded 

Maximum Inaccuracy ± 0.1% of range 

Maximum Full Scale Calibration

Error (not including offset error)

± 0.065% of full scale 

Maximum Offset Calibration Error ± 0.065% of full scale 

Accuracy vs. Temperature ±15 ppm/ °C maximum full scale calibration

change (± 0.025% of range / °C) 

Maximum Crosstalk -96 dB

Linearity Error (end to end) ±0.015% of range maximum

Monotonic with no missing codes 

Output Stability and Repeatability ±.015% after 10 min. warm-up typical 

Output Ripple .01% of Full Scale at 50/60 Hz 

Output Settling Time Rising Time 200µs

Falling Time 135µs

(full scale change) 

All Channel Update Rate 3.55 ms

Maximum Continuous Overload Outputs open circuit protected 

Type of Output Protection Electronically current limited to 20mA or less 

Output Signal (power-up, -down) � 4mA
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Removable Terminal Block Specifications
Number of Positions 20 screw terminals

Wire Range 22-14 AWG (0.324 to 2.08 sq. mm)  

Solid / stranded conductor

3/64 in. (1.2 mm) insulation maximum

"USE COPPER CONDUCTORS , 60°C" or equivalent.

Screw Driver Width 1/4 inch (6.5 mm) maximum

Screw Size M3 size

Screw Torque Field terminals – 7 - 9 in./lb (.0.882 - 1.02 Nm)

Self-jacking screws – 2.7 - 3.6 in./lb (0.3 - 0.4 Nm).

Do not overtighten screws when installing terminal block.



P3-8AD4DA-1 Analog Input/Output (continued)

*Meets EMC and Safety requirements. See the Declaration of Conformity for details.

WARNING: Explosion hazard – Substitution of components may
impair suitability for Class I, Division 2.
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General Specifications
Operating Temperature 0° to 60°C (32° to 140°F),

Storage Temperature -20° to 70°C (-4° to 158°F)

Humidity 5 to 95% (non-condensing)

Environmental Air No corrosive gases permitted 

Vibration MIL STD 810C 514.2

Shock MIL STD 810C 516.2

Field to Logic Side Isolation 1800VAC applied for 1 second

Insulation Resistance >10M� @ 500 VDC

Heat Dissipation 3.8 W

Enclosure Type Open Equipment

Agency Approvals UL508 file E157382, Canada & USA

UL1604 file E200031, Canada & USA

CE (EN61131-2*)

This equipment is suitable for use in Class 1,

Division 2, Groups A, B, C and D or non-hazardous 

locations only. 

Module Keying to Backplane Electronic

Module Location Any I/O slot in any local, expansion, or remote

base in a Productivity3000 System.

Field Wiring Removable terminal block (not included). Use

ZIPLink wiring system or optional terminal block.

See Chapter 3.

EU Directive See the "EU Directive" topic in the

Productivity3000 Help File. Information can also

be obtained at: www.productivitypac.com

Terminal Type (not included) 20-position removable terminal block

Weight 106.9g (3.76 oz)



P3-8AD4DA-1 Analog Input/Output (continued)
Wiring Diagrams

+

Current Input Circuits 

Current Output Circuits

COM

3-Wire Current
Transmitter

.032A2-Wire 4-20 mA
Transmitter

fuse

2-Wire Transmitter

3-Wire Transmitter

+24VDC User 
Supplied Power 

+ +

–

–

+

–

.032A

fuse

Note: Do not connect both ends of shield.

4-Wire 4-20 mA
Transmitter

4-Wire Transmitter

+

–

User Supplied
Transmitter Power 

AC or DC

4 - 20mA

Load

Note: Shield is connected to common at the source device.

+24VDC User 
Supplied Power 

An Edison S500-32-R

0.032A fast-acting fuse 

is recommended for all 

current loops.

.032A

fuse

+ –

24VDC- 

24VDC+ 

ISOLATED ANALOG
CIRCUIT COMMON

     I1+ 

     I2+ 

     I3+ 

I4+ 

     I5+ 

     I6+ 

     I7+ 

I8+ 

COM 

COM 

COM 

COM 

I1+ 

I2+ 

I3+ 

I4+ 

COM 

COM 

 

 

250Ω 

250Ω 

250Ω 

250Ω 

250Ω 

250Ω 

250Ω 

250Ω 

-    +

24 VDC User 
Supplied Power 

INTERNAL MODULE
CIRCUITRY

ISOLATED
ANALOG
CIRCUIT
POWER

 CH1 ADC

CH2 ADC

CH3 ADC

CH4 ADC

CH1 DAC

CH2 DAC

CH3 DAC

CH4 DAC

CH6 ADC

CH5 ADC

CH7 ADC

CH8 ADCIn
p

u
t

C
h

an
n

el
s

O
u

tp
u

t
C

h
an

n
el

s

Note: This module includes input and output channels. Before connecting 

field wiring, verify that you are connecting to the appropriate terminals.
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P3-8AD4DA-1 Analog Input/Output (continued)
Module Configuration

Using the Hardware Configuration tool in the Productivity Suite 
programming software, drag and drop the P3-8AD4DA-1 module into 
the base configuration.   
Select Automatic Module Verification or No Verification and Enable Hot 
Swap. Also specify Input Resolution for inputs and Stop Mode Value for 
outputs. If desired, assign a User Tagname to each input and output 
point (channel) selected and to each Status Bit Item.
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P3-8AD4DA-1 Analog Input/Output (continued)
LCD Panel Display

Note: 
SPARE 
denotes 
deselected 
channel 

Momentarily Press  

SEL button to 

toggle through 

secondary displays 

 













 






































Hold SEL button down to cycle through primary screens. Release button to select screen. 































Power On 








Appears 
initially 

These screens will  
then auto cycle 









































































Error Messages – An existing error will  
be inserted into the cycling Status Info screen 
 

















Fault Messages – Appear in  
place of data during a fault  
condition. 









This screen will  
auto cycle with 
status information 
 

On if input is greater than or 
equal to 20 mA.

On if input is less than or 
equal to 0 mA.
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P3-8AD4DA-2 Analog Input/Output
The P3-8AD4DA-2 Voltage Analog Input/Output Module provides eight channels of 0-5
VDC and 0-10 VDC inputs and four channels of 0-5 VDC and 0-10 VDC outputs.

ULC USR

We recommend using prewired ZIPLink cables and
connection modules. See Chapter 3. 

Terminal block cover included. If you wish to hand-
wire your module, a removable terminal block is
sold separately. Order part number P3-RTB. 

Input Specifications
Input channels 8 inputs (1 common)

Input ranges 0 - 5V, 0 - 10V 

Signal resolution 12-16 bit, depending on Input Resolution

0-5V Input Resolution & Update Rate

See Note 1
Fine: 7.1ms, 76µV, 16 bit 

Medium: 1.78ms, 305µV, 14 bit 

Coarse: 444µs, 1.22mV, 12 bit

0-10V Input Resolution & Update Rate

See Note 1
Fine: 7.1ms, 152µV, 16 bit 

Medium: 1.78ms, 610µV, 14 bit 

Coarse: 444µs, 2.44mV, 12 bit

Data Range 0 - 65535 counts

Maximum continuous overload ±100V, voltage input

Input impedance 1M � (± 10%) voltage input

Hardware Filter Characteristics Low pass 1st order, -3dB @ 80Hz

All Channel Update Rate 

See Note 2
Fine: 56.8ms 

Medium: 14.24ms

Coarse: 3.55ms

Conversion Method Over Sampling Successive Approx.

Accuracy vs. Temperature ±15PPM / °C Maximum

Maximum Inaccuracy 0.1% of range

Linearity Error (end to end) ±0.015% of range maximum

Monotonic with no missing codes

Input Stability and Repeatability ± 0.025% of range (after 10 min. warm up)

Full Scale Calibr. Error (minus offset) ±.05% of range maximum

Offset Calibration Error ±.05% of range maximum

Max Crosstalk -96dB

External DC Power Required 24 VDC (-20% / + 25%), 90mA maximum

Note 1: The Input Resolution of Fine returns 16 bit resolution. Medium and

Coarse are 14 and 12 bit respectively. The 12 and 14 bit input values are scaled

to 0-65535.

Note 2: Valid when all channels are set for the same Input Resolution.
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Terminal block sold
separately; terminal
block cover included

with module.



P3-8AD4DA-2 Analog Input/Output (continued)

Output Specifications
Output channels 4 (1 common)

Output ranges 0 - 10V, 0 - 5V

Output Signal resolution 16-bit

Resolution Value of LSB

(least significant bit)

0 - 5V = 76µV/count

0 - 10V = 152µV/count

1 LSB = 1 count 

Data Range 0 - 65535 counts

Output Type Voltage sourcing/sinking at 10mA max.

Output Value in Fault Mode 0V

Load Impedance �1125�

Maximum capacitive load .01µF maximum

Allowed Load Type Grounded

Maximum Inaccuracy 0.1% of range

Maximum Full Scale Calibration

Error (not including offset error)

±0.065% of range maximum

Maximum Offset Calibration Error ±0.065% of range maximum

Accuracy vs. Temperature ±25 ppm/ °C maximum full scale calibration

change (± 0.0025% of range / °C)

Max Crosstalk -96 dB

Linearity Error (end to end) 0.015% of full scale

Monotonic with no missing codes

Output Stability and Repeatability ±0.015% after 10 min. warm-up typical

Output Ripple .01% of Full Scale at 50/60 Hz

Output Settling Time 0.5 ms max, 5 µs min (full scale change)

All Channel Update Rate 5ms

Maximum Continuous Overload Outputs current limited to 15mA typical

Type of Output Protection 15VDC peak output voltage

Output Signal (power-up, -down) 0V
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Removable Terminal Block Specifications
Number of Positions 20 screw terminals

Wire Range 22-14 AWG (0.324 to 2.08 sq. mm)  

Solid / stranded conductor

3/64 in. (1.2 mm) insulation maximum

"USE COPPER CONDUCTORS , 60°C" or equivalent.

Screw Driver Width 1/4 inch (6.5 mm) maximum

Screw Size M3 size

Screw Torque Field terminals – 7 - 9 in./lb (.0.882 - 1.02 Nm)

Self-jacking screws – 2.7 - 3.6 in./lb (0.3 - 0.4 Nm).

Do not overtighten screws when installing terminal block.



P3-8AD4DA-2 Analog Input/Output (continued)

*Meets EMC and Safety requirements. See the Declaration of Conformity for details.

WARNING: Explosion hazard – Substitution of components may
impair suitability for Class I, Division 2.
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General Specifications
Operating Temperature 0° to 60°C (32° to 140°F),

Storage Temperature -20° to 70°C (-4° to 158°F)

Humidity 5 to 95% (non-condensing)

Environmental Air No corrosive gases permitted 

Vibration MIL STD 810C 514.2

Shock MIL STD 810C 516.2

Field to Logic Side Isolation 1800VAC applied for 1 second

Insulation Resistance >10M� @ 500 VDC

Heat Dissipation 2.5W 

Enclosure Type Open Equipment

Agency Approvals UL508 file E157382, Canada & USA

UL1604 file E200031, Canada & USA

CE (EN61131-2*)

This equipment is suitable for use in Class 1,

Division 2, Groups A, B, C and D or non-hazardous 

locations only. 

Module Keying to Backplane Electronic

Module Location Any I/O slot in any local, expansion, or remote

base in a Productivity3000 System.

Field Wiring Removable terminal block (not included). Use

ZIPLink wiring system or optional terminal block.

See Chapter 3.

EU Directive See the "EU Directive" topic in the

Productivity3000 Help File. Information can also

be obtained at: www.productivitypac.com

Terminal Type (not included) 20-position removable terminal block

Weight 105g (3.73 oz)



P3-8AD4DA-2 Analog Input/Output (continued)
Wiring Diagrams

-    +

24 VDC User 
Supplied Power 

INTERNAL MODULE
CIRCUITRY

24VDC-

24VDC+
ISOLATED
ANALOG
CIRCUIT
POWER

ISOLATED ANALOG
CIRCUIT COMMON

V1+

V4+

V8+

COM

COM

COM

COM

V1+

V2+

V3+

V4+

COM

COM

CH1 ADC

CH2 ADC

CH3 ADC

CH4 ADC

CH1 DAC

CH2 DAC

CH3 DAC

CH4 DAC

CH6 ADC

CH5 ADC

CH7 ADC

CH8 ADC

V2+

V3+

V5+

V6+

V7+

In
p

u
t

C
h

an
n

el
s

O
u

tp
u

t
C

h
an

n
el

s

Note: This module includes input and output channels. Before connecting 

field wiring, verify that you are connecting to the appropriate terminals.

V+

COM
4-Wire Voltage

Transmitter

4-Wire Transmitter

Voltage Input Circuits

Transmitter 
Power Supply

AC or DC

Voltage Output Circuits

V+

COM
0-5 VDC

Load

V+

COM
0-10 VDC

Load

-    +

24 VDC User 
Supplied Power 

3-Wire Voltage
Transmitter

V+

COM

3-Wire Transmitter

+

+

–
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P3-8AD4DA-2 Analog Input/Output (continued)

Module Configuration

Using the Hardware Configuration tool in the Productivity Suite 
programming software, drag and drop the P3-8AD4DA-2 module into 
the base configuration.   
Select Automatic Module Verification or No Verification and Enable Hot 
Swap. Also specify Input Range and Input Resolution for inputs along 
with Output Range and Stop Mode Value for outputs. If desired, assign 
a User Tagname to each input and output point (channel) selected and 
to each Status Bit Item.
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LCD Panel Display

Momentarily Press  

SEL button to 

toggle through 

secondary displays 

 













 






































Hold SEL button down to cycle through primary screens. Release button to select screen. 

















































Input signal is OVER the maximum 
detectable by the module.

Input signal = 0. (Voltage)

Fault Messages – Appear in 
place of data during a fault 
condition.

Power On 









Appears 
initially 

These screens will  
then auto cycle 
 





































































Error Messages – An existing error will  
be inserted into the cycling Status Info screen 
 









This screen will  
auto cycle with 
status information 
 

Note: 
SPARE 
denotes 
deselected 
channel 
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Hardware Maintenance

Standard Maintenance
The Productivity3000 is a low maintenance system requiring only a few periodic checks to
help reduce the risks of problems. Routine maintenance checks should be made regarding two
key items.

• Air quality (cabinet temperature, airflow, etc.)

• CPU battery

Air Quality Maintenance
The quality of the air your system is exposed to can affect system performance. If you have
placed your system in an enclosure, check to see that the ambient temperature is not
exceeding the operating specifications. If there are filters in the enclosure, clean or replace
them as necessary to ensure adequate airflow. A good rule of thumb is to check your system
environment every one to two months. Make sure the Productivity3000 is operating within
the system operating specifications. 

CPU Battery Replacement
A battery is included with the
P3-550 CPU, but is not
installed. The battery can be
installed to retain the Time and
Date along with any Tagname
values that are set up as
retentive. 

The battery is not needed for
program backup. 

Step One:
Press spring lock and swing 

battery compartment away 

from CPU.

Step Two
Insert battery and

close compartment.

Battery (Optional)
D2-BAT-1

Coin type, 3.0V Lithium 

battery, 560mA, battery

number CR2354

_

+



Diagnostics

Diagnostics 
Your Productivity3000 system performs many pre-defined diagnostic routines with every CPU scan.
The diagnostics have been designed to detect various types of failures for the CPU and I/O modules.
There are two primary error classes, critical and non-critical.

Critical Errors
Critical errors are errors the CPU has detected that offer a risk of the system not functioning safely or
properly. If the CPU is in Run Mode when the critical error occurs, the CPU will switch to Stop Mode.
(Remember, in Stop Mode all outputs are turned off.) If the critical error is detected while the CPU is in
Stop Mode, the CPU will not enter Run Mode until the error has been corrected. Here are some
examples of critical errors.

• Base power supply failure

• Parity error or CPU malfunction

• I/O configuration errors

• Certain programming errors

Non-Critical Errors
Non-critical errors are errors that are flagged by the CPU as requiring attention. They can neither
cause the CPU to change from Run Mode to Stop Mode, nor do they prevent the CPU from
entering Run Mode. There are system tags the application program can use to detect if a non-critical
error has occurred. The application program can be used to take the system to an orderly shutdown
or to switch the CPU to Stop Mode if necessary. 

Some examples of non-fatal errors are:

• Backup battery voltage low

• All I/O module errors

• Certain programming errors

Finding Diagnostic Information
The CPU automatically logs critical and non-critical error codes. This information can be
found in the following places marked with a time and date stamp.

• The LCD on the CPU module by scrolling through the menu.

• The PAC Error History window under the Monitor Debug tool of ProductivitySuite lists the 20 
most recent critical and non-critical errors.

Appendix B in this manual has a complete list of error messages sorted by error types.

Error Codes
See Appendix B for Productivity3000 Error Codes.
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CPU Indicators
The Productivity3000 CPU has indicators on the front to help you diagnose problems with
the system. The table below gives a quick reference of potential problems associated with
each status indicator. Following the table will be a detailed analysis of each of these indicator
problems.

Indicator Status Potential Problems

PWR (off) 
1. System voltage incorrect
2. Power supply/CPU is faulty
3. Other component such an I/O module has power supply shorted

RUN (will not come on) 
1. CPU programming error
2. Switch in STOP position

CPU (blink) CPU internal error

CPU Status Indicators
PWR Green LED is illuminated when power is on

RUN Green LED is illuminated when CPU is in

RUN mode

CPU Red LED is illuminated during power on

reset, power down, or watch-dog time-out.

UNLOCK
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PWR Indicator
There are three general reasons for the CPU power status LED (PWR) to be OFF:

1. Power to the base is incorrect or is not applied.

2. Base power supply is faulty.

3. Other component(s) have the power supply shut down.

Incorrect Base Power
If the voltage to the power supply is not correct, the CPU and/or base may not operate
properly or may not operate at all. Use the following guidelines to correct the problem.

WARNING: To minimize the risk of electrical shock, always disconnect the system power before
inspecting the physical wiring.

1. First, disconnect the system power and check all incoming wiring for loose connections.

2. If you are using a separate termination panel, check those connections to make sure the wiring is
connected to the proper location.

3. If the connections are acceptable, reconnect the system power and measure the voltage at the base
terminal strip to insure it is within specification. If the voltage is not correct shut down the system
and correct the problem.

4. If all wiring is connected correctly and the incoming power is within the specifications required,
the base power supply should be returned for repair.

Faulty CPU
There is not a good check to test for a faulty CPU other than substituting a known good one
to see if this corrects the problem. If you have experienced major power surges, it is possible
the CPU and power supply have been damaged. If you suspect this is the cause of the power
supply damage, a line conditioner which removes damaging voltage spikes should be used in
the future. 
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Device or Module Causing the Power Supply to Shutdown
It is possible a faulty module can shut down the power supply. This 5V can be coming from
the base or from the CPU communication ports.

To test for a device causing this problem:
1. Turn off power to the CPU.

2. Disconnect all external devices (i.e., communication cables) from the CPU.

3. Reapply power to the system.

If the power supply operates normally you may have either a shorted device or a shorted
cable. If the power supply does not operate normally then test for a module causing the
problem by following the steps below:

If the PWR LED operates normally the problem could be in one of the modules. To isolate
which module is causing the problem, disconnect the system power and remove one module
at a time until the PWR LED operates normally. Follow the procedure below:

• Turn off power to the base.

• Remove a module from the base.

• Reapply power to the base.

Bent base connector pins on the module can cause this problem. Check to see the connector
is not the problem.
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Run Indicator
If the CPU will not enter the Run mode (the RUN indicator is off ), the problem is usually
in the application program, unless the CPU has a critical error. If a critical error has
occurred, the CPU LED should be on. (You can use a programming device to determine the
cause of the error.)

A complete list of error codes can be found in Appendix B.

CPU Indicator
If the CPU indicator is on, a critical error has occurred in the CPU. Generally, this is not a
programming problem but an actual hardware error. The CPU indicator should blink briefly
and then do an automatic reboot. 

If the error clears, you should monitor the system and determine what caused the problem.
You will find this problem is sometimes caused by high frequency electrical noise introduced
into the CPU from an outside source. Check your system grounding and install electrical
noise filters if the grounding is suspected. If power cycling the system does not reset the
error, or if the problem returns, you should replace the CPU.

Communications Problems
If you cannot establish communications with the CPU, check these items.

• The cable is disconnected.

• The cable has a broken wire or has been wired incorrectly.

• The cable is improperly terminated or grounded.

• The device connected is not operating at the correct baud rate.

• The device connected to the port is sending data incorrectly.

• A grounding difference exists between the two devices.

• Electrical noise is causing intermittent errors.

• The CPU has a bad communication port and the CPU should be replaced.

If an error occurs, the indicator will come on and stay on until a successful communication
has been completed.
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I/O Module Troubleshooting

Things to Check
If you suspect an I/O error, there are several things that could be causing the problem.

• A blown fuse

• A loose terminal block

• The 24 VDC supply has failed

• The module has failed

• The I/O configuration check detects a change in the I/O configuration

Error Codes
See Appendix B for Productivity3000 error code information.

Also, in the Productivity Suite programming software, you can go to:

Tools > PAC Error History, and

Tools > PAC Event History

Next, “Read CPU Error/Event History to get an updated list of critical errors, non-critical
errors and events that should indicate problems or changes to the I/O. This list will give the
“GBS” (group, base, slot numbers).

Some Quick Steps
When troubleshooting the Productity3000 I/O modules there are a few facts you should be
aware of which may assist you in quickly correcting an I/O problem:

• The output modules cannot detect shorted or open output points. If you suspect one or more
points on a output module to be faulty, you should measure the voltage drop from the common to
the suspect point. Remember, when using a Digital Volt Meter, leakage current from an output
device, such as a triac or a transistor, must be considered. A point which is off may appear to be on
if no load is connected to the point.

• The I/O point status indicators on the modules are logic side indicators. This means the LED
which indicates the on or off status reflects the status of the point in respect to the CPU. On an
output module, the status indicators could be operating normally, while the actual output device
(transistor, triac etc.) could be damaged. With an input module, if the indicator LED is on, the
input circuitry should be operating properly. To verify proper functionality, check to see that the
LED goes off when the input signal is removed.

• Leakage current can be a problem when connecting field devices to I/O modules. False input
signals can be generated when the leakage current of an output device is great enough to turn on
the connected input device. To correct this, install a resistor in parallel with the input or output of
the circuit. The value of this resistor will depend on the amount of leakage current and the voltage
applied but usually a 10K to 20K resistor will work. Ensure the wattage rating of the resistor is
correct for your application.

• The easiest method to determine if a module has failed is to replace it if you have a spare. However,
if you suspect another device to have caused the failure in the module, that device may cause the
same failure in the replacement module as well. As a point of caution, you may want to check
devices or power supplies connected to the failed module before replacing it with a spare module.
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Testing Output Points
Output points can be set on or off using the force function to override a point even while
the program is running. However, this is not a recommended method to test the output
points. If you want to do an I/O check independent of the application program, follow this
procedure:

WARNING: Depending on your application, forcing I/O points may cause unpredictable machine
Operation that can result in a risk of personal injury or equipment damage. Make sure you have taken
all appropriate safety precautions prior to testing any I/O points.

The LCD on Analog /O modules displays actual voltage, current, and digital values without
connecting a meter.

Step Action
1 Use ProductivitySuite programming software to communicate online to the PAC.
2 Change to Program Mode.
3 Go to the first rung of the ladder.

4 Insert a rung with an “END” statement. (This will cause program execution to occur only at address 0
and prevent the application program from turning the I/O points on or off).

5 Change to Run Mode.
6 Use the programming device to set (turn) on or off the points you wish to test.
7 When you finish testing I/O points delete the “END” statement at the first rung.
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Noise Troubleshooting

Electrical Noise Problems
Noise is one of the most difficult problems to diagnose. Electrical noise can enter a system in
many different ways and falls into one of two categories, conducted or radiated. It may be
difficult to determine how the noise is entering the system but the corrective actions for
either of the types of noise problems are similar.

• Conducted noise is when the electrical interference is introduced into the system by way of an
attached wire, panel connection, etc. It may enter through an I/O module, a power supply
connection, the communication ground connection, or the chassis ground connection.

• Radiated noise is when the electrical interference is introduced into the system without a direct
electrical connection, much in the same manner as radio waves.

Reducing Electrical Noise
While electrical noise cannot be eliminated it can be reduced to a level that will not affect the
system.

• Most noise problems result from improper grounding of the system. A good earth ground can be
the single most effective way to correct noise problems. If a ground is not available, install a ground
rod as close to the system as possible. Ensure all ground wires are single point grounds and are not
daisy chained from one device to another. Ground metal enclosures around the system. A loose
wire is no more than a large antenna waiting to introduce noise into the system; therefore, you
should tighten all connections in your system. Loose ground wires are more susceptible to noise
than the other wires in your system. Review Chapter 3, Installation and Wiring, if you have
questions regarding how to ground your system.

• Electrical noise can enter the system through the power source for the CPU and I/O. Installing an
isolation transformer for all AC sources can correct this problem. DC power sources should be well
grounded, good quality power supplies. Switching DC power supplies commonly generate more
noise than linear supplies.

• Separate input wiring from output wiring. Never run I/O wiring close to high voltage wiring.
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Run Time vs. Stop Mode Transfer Instruction
Here we describe the actions and differences between Run Time & Stop Mode transfers.

The above dialog is accessed two ways: 

1. From the Transfer to PAC icon on the tool bar, or 

2. From the File menu > Transfer Project > To PAC
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Run Time Transfers
Run Time transfers allow the user to transfer edits to a project back into the CPU without
stopping the CPU scan, therefore not stopping the process. Be aware that a Run Time
transfer will affect the length of your scan time, which should be considered if your process is
susceptible to varying or lengthy scan times. The download time is longer compared to a
Stop Mode transfer. 

During a Run Time transfer, the current project file continues running until the entire
project file is transferred to the CPU. Once downloaded, the ladder logic files swap and
begin executing the new file. The Tag Database is shared between the two project files during
a Run Time transfer, therefore current operating values will not be effected. 

Because the Tag database is shared, any edits to the Tag database will force a Stop Mode
transfer.

Stop Mode Transfers

Stop Mode transfers allows the user to transfer any and all ladder, Tag database and
configuration changes to the CPU. 

Because the CPU is in stop mode, the project transfer is much faster than a Run Time
transfer and also loads all initial values to the tags once the project is switched from Stop to
Run.

There are also conditions that will force the user to perform a Stop Mode transfer. 

1.  Any changes to the hardware configuration, such as:

A.  Adding or removing hardware.

B.  Changing the configuration of a piece of hardware.
•  Ethernet or serial port configuration.

•  Hot swap enable or disable on any module or base.

2.  Adding or changing any Array data type Tags.

3.  Adding or changing any String data type Tags.

Note: Be careful when performing a Stop Mode transfer. The retentive values in your PC
project may not be current and non-retentive data will be cleared (reset to 0) when you
switch your CPU from Stop to Run.



There are steps you can take to ensure that your data is as current as possible before
performing a transfer. 

1.  A Run Time transfer does not load initial values and therefore the best method for keeping data
current. However, a Run Time transfer is not always allowed. (see the preceding list of
conditions that will force a Stop Mode transfer.)

2.  Select “Upload current retentive values and copy to initial values” from the Tools menu >
Options > Project Transfer tab.

With this option selected, you can place the CPU in Stop mode so retentive values are stable,
upload the project, perform your edits, and then transfer the project back to the CPU.
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Forcing I/O Points
Here we are going to describe the actions, expectations and indications when forcing a value
within the Productivity3000 controller. 

Advantages of Forces
Almost all tags can be written to within your software without the use of Forces. However, if
the ladder logic or an external device (Operator interface panel, Modbus device, etc.) is
connected to your controller and writing to those tags, the values you write from a Data View
will be over-written. Conversely, if you write a Force value, this will not be overwritten or
reset until you manually remove the force or reset by means of a Stop to Run mode
transition, Stop mode project transfer, or a controller power cycle.

Enabling Forces
The Productivity3000 is a Tag based controller and forcing a tag begins by identifying any tag
you wish to be “Forceable” within the Tag database. 
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There are three columns within the Tag database that affect the forcing of all tags. 

1. “Forceable” - Checking the box in this column identifies the corresponding tag as being able to
be forced within the system.

2. “Init Forced” - Checking the box in this column identifies that corresponding tag as being forced
as soon as the project is loaded and the processor is switched to Run mode.

3. “Init Force Value”  - The state of the box in this column identifies the initial forced state of the
Boolean tag:

•  A check mark in a box equals a logical “1” or “ON”, and

•  An unchecked box equals a logical ”0” or “OFF”. The value placed in this field for Integer or 
Floating point tags will be written into the tag. 

Forcing Tags in Your System
All forcing of tags is accomplished through the Data View window.
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From the DataView Window, enter the tags you wish to force, or you can view all forceable
tags from the “Forceable Tags” tab automatically created for you when you enable tags as
forceable in the tag database.

From either of these windows you have the option to select the check box in the Force
column. When this box is checked and the row is selected (selected rows show high-lighted
blue) and you select the Send Edit(s) button, the current row(s) will be forced. 

Note: You can select multiple rows by clicking and holding down the left mouse button and dragging up or
down. This selects consecutive rows. If you wish to select various rows, simple hold the “Ctrl” control key
on your keyboard while left mouse clicking the rows.
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Identifying Forced Values
There are two indications that forces are active on your controller. 

1. All active forces will be shown in the Forceable tab of the Data View window as shown in the
previous view.

2. You will also see “PAC Data Forced” in Red in the lower right of the Status bar of your software.

Note: Only Forced tags with an initial force value specified in the Tag database will be retained after a Stop
to Run transition, Stop Mode transfer, or a power cycle. All forced values are retained during a 
Run Time transfer.
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Force Value Timing Chart
You chart below show the varying states of a Digital Output & Input represented in the logic
rung when no edits or forces are applied, when edits are applied and when forces are applied.

Input “Logical” represents the logical value of the digital input.

Input “Edit” represents an edit sent to a digital input from the Data View, but not forced.
This value is written once but then over-written the very next scan by the logical input.

Input “Forced” represents a Force sent to the input from the Data View. At any point when
the Force is active the Input logic is On or High.

Output “logical” represents the logical value of the digital output.

Output “Edit” represents an edit sent to a digital output from the Data View, but not forced.
Unlike the input edits, this is edit will not register is another value is writing to the output,
but will transition the output On or High if there are no other logistic or outside factors. 

Output “Forced” represents a Force sent to the output from the Data View. At any point
when the Force is active the Output logic is On or High.
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Input DI-0.1.1.1
logical

DI-0.1.1.1
0

DI-0.1.3.1
0

Input DI-0.1.1.1
Edit

Input DI-0.1.1.1
Forced

Output DO-0.1.3.1
logical

Output DO-0.1.3.1
Edit

Output DO-0.1.3.1
Forced

OUT
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European Union (EU) Directives

NOTE: The information contained in this section is intended as a guideline and is based on our
interpretation of the various standards and requirements. Since the actual standards are issued by other
parties, and in some cases governmental agencies, the requirements can change over time without advance
warning or notice. Changes or additions to the standards can possibly invalidate any part of the information
provided in this section.

This area of certification and approval is absolutely vital to anyone who wants to do business
in Europe. One of the key tasks that faced the EU member countries and the European
Economic Area (EEA) was the requirement to bring several similar yet distinct standards
together into one common standard for all members. The primary purpose of a single
standard was to make it easier to sell and transport goods between the various countries and
to maintain a safe working and living environment. The Directives that resulted from this
merging of standards are now legal requirements for doing business in Europe. Products that
meet these Directives are required to have a CE mark to signify compliance.

Member Countries
As of January 1, 2007, the members of the EU are Austria, Belgium, Bulgaria, Cyprus, Czech
Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Ireland, Italy,
Latvia, Lithonia, Luxembourg, Malta, Netherlands, Poland, Portugal, Romania, Slovakia,
Slovenia, Spain, Sweden, and United Kingdom. Iceland, Liechtenstein, and Norway together
with the EU members make up the European Economic Area (EEA) and all are covered by
the Directives.

Applicable Directives
There are several Directives that apply to our products. Directives may be amended, or added,
as required.

• Electromagnetic Compatibility Directive (EMC) — this Directive attempts to ensure that devices,
equipment, and systems have the ability to function satisfactorily in an electromagnetic
environment without introducing intolerable electromagnetic disturbance to anything in that
environment.

• Machinery Safety Directive — this Directive covers the safety aspects of the equipment,
installation, etc. There are several areas involved, including testing standards covering both electrical
noise immunity and noise generation.

• Low Voltage Directive — this Directive is also safety related and covers electrical equipment that
has voltage ranges of 50–1000VAC and/or 75–1500VDC.

• Battery Directive — this Directive covers the production, recycling, and disposal of batteries.

Compliance
Certain standards within each Directive already require mandatory compliance. The EMC
Directive, which has gained the most attention, became mandatory as of January 1, 1996.
The Low Voltage Directive became mandatory as of January 1, 1997.

Ultimately, we are all responsible for our various pieces of the puzzle. As manufacturers, we
must test our products and document any test results and/or installation procedures that are
necessary to comply with the Directives. As a machine builder, you are responsible for 
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installing the products in a manner which will ensure compliance is maintained. You are also
responsible for testing any combinations of products that may (or may not) comply with the
Directives when used together. The end user of the products must comply with any Directives
that may cover maintenance, disposal, etc. of equipment or various components. Although we
strive to provide the best assistance available, it is impossible for us to test all possible configurations
of our products with respect to any specific Directive. Because of this, it is ultimately your
responsibility to ensure that your machinery (as a whole) complies with these Directives and to keep
up with applicable Directives and/or practices that are required for compliance.

Productivity3000 systems manufactured by Koyo Electronics Industries or FACTS
Engineering, when properly installed and used, conform to the Electromagnetic
Compatibility (EMC), Low Voltage Directive, and Machinery Directive requirements of the
following standards.

• Product Specific Standard for Programmable Controllers
EN61131–2:2003 Programmable controllers, equipment requirements and tests. 

This is the product specific standard for PACs and covers the low voltage and EMC directives as
required for European CE certification. This standard has many tests together with test procedures
and limits, but also references the below standards for some tests:

IEC 60068-2-1:1990 part 2 tests A, 60068-2-2:1974 part 2 test B, IEC 60068-2-6:1995, Part 2: Test
Fc, IEC 60068-2-14:1984 Part 2 Test N,  IEC 60068-2-27:1987 Part 2 Test Ea, IEC 60068-2-
30:1980, Part 2 Test Db, IEC 60068-2-31:1969 Part  Test Ec, IEC 60068-2-32:1975 Part 2 Test Ed,
IEC 60417 (all parts), IEC 60664-1:1992 Part 1, IEC 60664-3:1992, IEC 60695-2-1 (all sheets),
Part 2: IEC 60707:1999 IEC 60947-5-1:1997 Part 5-1 IEC 60947-7-1:2002 Part 7-1, I EC 60950-
1:2001 Part 1, IEC 61000-4-2:1995, Part 4-2, IEC 61000-4-3:2002 Part 4-3, IEC 61000-4-4:1995,
IEC 61000-4-5:1995 Part 4-5, IEC 61000-4-6:1996, Part 4-6, IEC 61000-4-8:1993 Part 4-8, IEC
61000-4-12:1995 Part 4-12, IEC 61010-1:2001 Part 1, CISPR 11:1999, CISPR 16-1:1999 Part 1,
CISPR 16-2:1999 Part 2

For undated references, the latest edition of the referenced document (including any amendments)
applies.

• Warning on Electrostatic Discharge (ESD)
We recommend that all personnel take necessay precautions to avoid the risk of transferring static
charges to inside the control cabinet, and clear warnings and instructions should be provided on the
cabinet exterior. Such precautions may include the use of earth straps, grounding mats and similar
static-control devices, or the powering off of the equipment inside the enclosure before the door is
opened.

• Warning on Radio Interference (RFI)
This is a class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

General Safety
• External switches, circuit breaker or external fusing, are required for these devices.

• The switch or circuit breaker should be mounted near the programmable controller equipment.
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Special Installation Manual
The installation requirements to comply with the requirements of the Machinery Directive,
EMC Directive and Low Voltage Directive are slightly more complex than the normal
installation requirements found in the United States. To help with this, we have published a
special manual which you can order or download from our website:

• DA–EU–M – EU Installation Manual that covers special installation requirements to meet the EU
Directive requirements. Refer to this manual for updated information.

Other Sources of Information
Although the EMC Directive gets the most attention, other basic Directives, such as the
Machinery Directive and the Low Voltage Directive, also place restrictions on the control
panel builder. Because of these additional requirements it is recommended that the following
publications be purchased and used as guidelines:

• BSI publication TH 42073: February 1996 – covers the safety and electrical aspects of the
Machinery Directive

• EN 60204–1:1992 – General electrical requirements for machinery, including Low Voltage and
EMC considerations

• IEC 1000–5–2: EMC earthing and cabling requirements

• IEC 1000–5–1: EMC general considerations

It may be possible for you to obtain this information locally; however, the official source of
applicable Directives and related standards is:

The Office for Official Publications of the European Communities L–2985 Luxembourg;
quickest contact is via the web at http://publications.europa.eu

Another source is:

British Standards Institution – Sales Department

Linford Wood

Milton Keynes

MK14 6LE

United Kingdom; the quickest contact is via the web at www.bsigroup.com

Basic EMC Installation Guidelines

Enclosures
The simplest way to meet the safety requirements of the Machinery and Low Voltage
Directives is to house all control equipment in an industry standard lockable steel enclosure.
This normally has an added benefit because it will also help to reduce EMC emissions.
Although the RF emissions from the programmable controller equipment, when measured in
the open air, are well below the EMC Directive limits, certain configurations can increase
emission levels. Holes in the enclosure, for the passage of cables or to mount operator
interfaces, can increase emissions.
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Mains Filters
Productivity3000 AC powered base power supplies do not require extra mains filtering to
comply with the EMC Directive on conducted RF emissions.

DC powered base power supplies require a mains filter. A CORCOM 6MV1 filter was tested
and reduced emissions to an acceptable level.

Suppression and Fusing
In order to comply with the fire risk requirements of the Low Voltage and Machinery
Directive standards EN 61010–1 and EN 60204–1, it is necessary to fuse both sides of the
power inputs (on both AC and DC units).

Transient suppressors must be protected by fuses and the capacity of the transient suppressor
must be greater than the blow characteristics of the fuses or circuit breakers to avoid a fire
risk. A recommended AC supply input arrangement for the Productivity 3000 is to use twin
3 amp TT fused terminals with fuse blown indication, such as DINnectors DN–F10L
terminals, or twin circuit breakers. 

Internal Enclosure Grounding
A heavy-duty star earth terminal block should be provided in every cubicle for the connection
of all earth ground straps, protective earth ground connections, mains filter earth ground
wires, and mechanical assembly earth ground connections. This should be installed to comply
with safety and EMC requirements, local standards, and the requirements found in IEC
1000–5–2. The Machinery Directive also requires that the common terminals of the
programmable controller input modules, and common supply side of loads driven from
programmable controller output modules should be connected to the protective earth ground
terminal.

Equi–potential Grounding
Adequate site earth grounding must be provided for equipment containing modern electronic
circuitry. The use of isolated earth electrodes for electronic systems is forbidden in some
countries. Make sure you check any requirements for your particular destination. IEC
1000–5–2 covers equi-potential bonding of earth grids adequately, but special attention
should be given to apparatus and control cubicles that contain I/O devices, remote I/O racks,
or have inter-system communications with the primary PAC system enclosure. An equi-
potential bond wire must be provided alongside all serial communications cables, and to any
separate items of the plant which contain I/O devices connected to the programmable
controller. The diagram shows an example of four physical locations connected by a
communications cable.
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Communications and Shielded Cables

Good quality 24 AWG minimum twisted-pair shielded cables, with overall foil and braid
shields are recommended for analog cabling and communications cabling outside of the
programmable controller enclosure. To date it has been a common practice to only provide an
earth ground for one end of the cable shield in order to minimize the risk of noise caused by
earth ground loop currents between apparatus. The procedure of only grounding one end,
which primarily originated as a result of trying to reduce hum in audio systems, is no longer
applicable to the complex industrial environment. Shielded cables are also efficient emitters of
RF noise from the PAC system, and can interact in a parasitic manner in networks and
between multiple sources of interference.

The recommendation is to use shielded cables as electrostatic “pipes” between apparatus and
systems, and to run heavy gauge equi-potential bond wires alongside all shielded cables.
When a shielded cable runs through the metallic wall of an enclosure or machine, it is
recommended in IEC 1000–5–2 that the shield should be connected over its full perimeter to
the wall, preferably using a conducting adapter, and not via a pigtail wire connection to an
earth ground bolt. Shields must be connected to every enclosure wall or machine cover that
they pass through.
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Analog and RS232 Cables
Providing an earth ground for both ends of the shield for analog circuits provides the perfect
electrical environment for the twisted pair cable as the loop consists of signal and return, in a
perfectly balanced circuit arrangement, with connection to the common of the input circuitry
made at the module terminals. RS232 cables are handled in the same way.

Multidrop Cables
RS422 twin twisted pair, and RS485 single twisted pair cables also require a 0V link, which
has often been provided in the past by the cable shield. It is now recommended that you use
triple twisted pair cabling for RS422 links, and twin twisted pair cable for RS485 links. This
is because the extra pair can be used as the 0V inter-system link. With loop DC power
supplies earth grounded in both systems, earth loops are created in this manner via the inter-
system 0v link. The installation guides encourage earth loops, which are maintained at a low
impedance by using heavy equi-potential bond wires. To account for non–European
installations using single-end earth grounds, and sites with far from ideal earth ground
characteristics, we recommend the addition of 100 ohm resistors at each 0V link connection
in network and communications cables.

Shielded Cables within Enclosures
When you run cables between programmable controller items within an enclosure which also
contains susceptible electronic equipment from other manufacturers, remember that these
cables may be a source of RF emissions. There are ways to minimize this risk. Standard data
cables connecting PACs and/or operator interfaces should be routed well away from other
equipment and their associated cabling. You can make special serial cables where the cable
shield is connected to the enclosure’s earth ground at both ends, the same way as external
cables are connected.

Analog Modules and RF Interference
The readings from all analog modules will be affected by the use of devices that exhibit high
field strengths, such as mobile phones and motor drives.

All AutomationDirect products are tested to withstand field strength levels up to 10V/m,
which is the maximum required by the relevant EU standards. While all products passs this
test, analog modules will typically exhibit deviations of their readings. This is quite normal,
however, systems designers should be aware of this and plan accordingly.

When assembling a control system using analog modules, these issues must be adhered to and
should be integrated into the system design. This is the responsibility of the system
builder/commissioner.
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Network Isolation
For safety reasons, it is a specific requirement of the Machinery Directive that a keyswitch
must be provided that isolates any network input signal during maintenance, so that remote
commands cannot be received that could result in the operation of the machinery. To avoid
the introduction of noise into the system, any keyswitch assembly should be housed in its
own earth grounded steel box and the integrity of the shielded cable must be maintained.

Again, for further information on EU directives we recommend that you get a copy of our
EU Installation Manual (DA–EU–M). Also, you can check the EU Commision’s official web
site at: 

http://publications.europa.eu.

It is good Engineering practice to install toroid inductors on the I/O wiring and the
communications cables such as listed in the table below.
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Toroid Inductors
Manufacturer Mfg. Part Number Outside Diameter Inside Diameter Length
RS Online 260–6795 17.5 mm 9.5 mm 28.5 mm

Fair-Rite 2643665702 17.5 mm 9.5 mm 28.5 mm

Wurth Elektronick 742 700 9 17.5 mm 9.5 mm 28.5 mm
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Items Specific to the Productivity3000
• The rating between all circuits in this product are rated as basic insulation only, as appropriate for

single fault conditions.

• It is the responsibility of the system designer to earth one side of all control and power circuits, and
to earth the braid of screened cables.

• This equipment must be properly installed while adhering to the guidelines of the in house PAC
installation manual DA–EU–M, and the installation standards IEC 1000–5–1, IEC 1000–5–2 and
IEC 1131–4.

• It is a requirement that all PLC equipment must be housed in a protective steel enclosure, which
limits access to operators by a lock and power breaker. If access is required by operators or untrained
personnel, the equipment must be installed inside an internal cover or secondary enclosure. 

• It should be noted that the safety requirements of the machinery directive standard EN60204–1
state that all equipment power circuits must be wired through isolation transformers or isolating
power supplies, and that one side of all AC or DC control circuits must be earthed.

• Both power input connections to the programmable controller must be separately fused using 3
amp T type anti–surge fuses, and a transient suppressor fitted to limit supply overvoltages.

• If the equipment is used in a manner not specified by the manufacturer the protection provided by
the equipment may be impaired.
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In This Appendix:

Productivity3000 Error Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–1
Communications Error Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–2
Module Error Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–3
PAC Error Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–4
Project Error Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–5
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Communications Error Codes

Error Code Description Suggested Fix

01 Function Code not supported Check instruction or connected device and correct
Function code or address range selected.

02
Address out of range.  This error is typically
generated when a Modbus address has been
requested that does not exist in the CPU.

Check instruction or connected device and correct
Function code or address range selected.

03
Illegal Data Value.  This error is typically generated
when the Modbus request sent to the CPU is formed
incorrectly.

Check the Modbus request against the Modbus protocol
specification (www.modbus.org) to verify that it was
formed correctly.

04 Device Failure Check connected device
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Module Error Codes

Error Code Cause Description

E2101 One or more module status bits are set.
Examine the individual module status bits for the
modules(s) in question to determine the cause of the error
and appropriate action.

E2201 / E2202 Intelligent module is not communicating. Remove and reinstall the module. If the problem persists,
the module is defective and must be repaired or replaced.

E2203
P3-EX is not communicating with P3-550 or P3-RS.
Or, local base is not communicating with its P3-550
or P3-RS. Hot swap is enabled for the base.

Verify base has power. Disconnect and reconnect base
communication cable. If problem persists, replace base
communication cable, or P3-EX. If problem persists cycle
power to base. If the problem persists, restart system. 

E2204
P3-EX is not communicating with P3-550 or P3-RS.
Or, local base is not communicating with its P3-550
or P3-RS. Hot swap is not enabled for the base.

Verify base has power. Disconnect and reconnect base
communication cable. If problem persists, replace base
communication cable, or P3-EX. If problem persists cycle
power to base. If the problem persists, restart system. 

E2205 P3-RS is not communicating with P3-550. Hot swap
is enabled for the entire remote base group.

Verify that the P3-RS is properly connected via Ethernet to
the P3-550 Remote I/O port and that the P3-RS is
powered on. If problem persists, verify that Ethernet
equipment such as switches and cables are functioning
properly.

E2206 P3-RS is not communicating with P3-550. Hot swap
is not enabled for the entire remote base group.

Verify that the P3-RS is properly connected via Ethernet to
the P3-550 Remote I/O port and that the P3-RS is
powered on. If problem persists, verify that Ethernet
equipment such as switches and cables are functioning
properly.

E2207 Multiple remote slaves are set to same group
number.

Make sure that each P3-RS in the network is set to a
unique group number. 

E2208 An expansion base is connected to the USB OUT port
on the CPU. Move cable to EXP I/O OUT port. 

E2301 Expected module is not installed, or the installed
module is defective. Hot swap is enabled for the slot. Install the correct module.

E2302
Expected module is not installed, or the installed
module is defective. Hot swap is not enabled for the
slot. 

Install the correct module.

E2401 GS-Drive configuration cannot be transferred to 
GS-Drive due to communications error. 

Make sure GS-Drive is in STOP mode and motor is not in
motion, then either power-cycle CPU or re-transfer project
to CPU.

E2402
GS-Drive configuration cannot be trasferred to 
due to GS-Drive error. Number in parentheses is
MODBUS exception code. 

Verify E-Drive and GS-Drive are properly installed and
functioning, then either power-cycle CPU or re-transfer
project to CPU.

E2403 GS-Drive configuration cannot be transferred to 
GS-Drive while motor is in motion.

Make sure GS-Drive is in STOP mode and motor is not in
motion, verify all Ethernet equipment is properly installed
and configured, then either power-cycle CPU or re-transfer
project to CPU.

E2404
GS-Drive configuration cannot be transferred to 
GS-Drive because GS drive type and model do not
match project. 

Correct GS drive type and model in project.
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PAC Error Codes

Error Code Cause Description

E5101 The P3-550 battery is low. Replace CPU’s Battery

E5102 The Base identifier (EPROM) is invalid. Replace the unit. If unit is in warranty, call AutomationDirect for
an RA number.

E5103 The P3-550 or P3-RS cannot communicate
with the User Interface Module (LCD).

Replace the unit. If unit is in warranty, call AutomationDirect for
an RA number.

E5104
Too many display messages were sent to
the User Interface Module (LCD) in a short
period of time.

Reduce the rate at which messages to the LCD are triggered.

E5105
The User Interface Module (LCD) did not
receive firmware from the P3-550 or 
P3-RS.

If error persists after power cycle, replace the unit. If unit is in
warranty , call AutomationDirect for an RA number. 

E5120 The module specified has a Firmware Error. Replace the unit. If unit is in warranty, call AutomationDirect for
an RA number.

E5121 The module specified has a Hardware Error. Replace the unit. If unit is in warranty, call AutomationDirect for
an RA number.

E5122 The module specified has an Internal Error. Replace the unit. If unit is in warranty, call AutomationDirect for
an RA number.
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Project Error Codes

Error Code Cause Description

E03000 -E03199 Internal firmware file system error. Power cycle CPU. If problem persists, contact AutomationDirect for
repair or replacement. 

E03201 - E03299 Internal firmware operating system error. Power cycle CPU. If problem persists, contact AutomationDirect for
repair or replacement. 

E03301 Unable to exit RUN mode. Power cycle CPU. If problem persists, contact AutomationDirect for
repair or replacement. 

E03801 - E03899 Internal firmware USB error. Problem should self recover. If problem persists, power cycle CPU.

E03901 A scan exceeded the timeout specified in
P3-550 Hardware Configuration.

Verify that For/Next loops are handled properly. Adjust the timeout
setting.

E04101
Scan attempted access beyond array
limits. Txxxx is task ID. Rxxxx is rung
number.

Correct problem in ladder logic or data that caused invalid access.

E04201 Internal firmware Data Logging error. Problem should self recover. If problem persists, power cycle CPU.

E04202 Cannot create data logging folder. Ensure a supported storage device is properly installed in USB OUT
port on CPU. If problem persists, restart system. 

E04203 Cannot write data to data logging
storage device.

Ensure a supported storage device is properly installed in USB OUT
port on CPU. If problem persists, restart system. 

E04204 Internal firmware Data Logging buffer is
greater than 50% full. Problem should self recover. If problem persists, power cycle CPU.

E04205 Internal firmware Data Logging buffer
overflow. Problem should self recover. If problem persists, power cycle CPU.

E04210 Invalid system ID found while loading
project. Load new project.

E04220 Email instruction failed. Problem should self recover. If problem persists, power cycle CPU.

E04230 Base firmware may be corrupt.
Power cycle base. If problem persists, power cycle CPU or P3-RS.
If problem persists, reload firmware for the CPU or the P3-RS in
control of the Base Group.

Continued on next page
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Project Error Codes - Continued

Error Code Cause Description

E04300 - E04302 A project file is missing. Load new project.

E04303 Internal firmware project
loader failure. Problem should self recover. If problem persists, power cycle CPU.

E04304
Project load failure limit
exceeded. Project has been
removed.

Load new project.

E04305 - E04306 Internal firmware project
loader failure. 

Problem should self recover. If problem persists, power cycle CPU. If
problem persists, load new project.

E04307 Project file corrupt. Load new project.

E04308 - E04315 Internal firmware project
loader failure. Load new project.

E04316 Project upload failed. Retry the process.

E04317 Internal firmware project
loader failure. Load new project.

E04318 Modbus TCP connection limit
exceeded.

Reduce the number of Modbus TCP devices used in project and/or
external master devices.

E04319 Internal error. Problem should self recover. If problem persists restart CPU.

E04320
One or more RS232
parameters contain invalid
values.

Verify that all RS232 parameters in project contain valid settings.

E04321
One or more RS485
parameters contain invalid
values.

Verify that all RS485 parameters in project contain valid settings.




